
ABOUT SHAREWARE

The Shareware idea is beneficial to you.    You benefit from this "try it before you buy it" approach 
because it enables you to obtain the program at a small investment. Typically your small 
investment is only the charge for the telephone connection to a bulletin board. If you order a trial 
copy from a Shareware vendor your small investment is the price of the disks and shipping 
usually $5 -- $10.    Now you just need to spend time deciding if the program meets your needs.

If after a reasonable trial period you wish to continue using the program, you must then register it. 
Registration will allow you to obtain the latest version of the program.    Registration also will 
provide notification of upgrades when available and our world class technical support.    However, 
if after the trial period, you do not find the program suitable, you should stop using the program.

See Order Form    and Next Release 

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or when the pointer is over the topic, the pointer changes to a hand icon.



OPTIONS OVERVIEW:

This section customizes PAYOFF! for your needs.

Also see Payoff! Categories:

Change Fonts Overview

Sort Options Overview

Display Options Overview

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



CHANGE FONTS OVERVIEW
Changing fonts allows you to give your screen or report a custom look. Your choice of type styles 
depends on the printers or screen drivers you have installed.

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



CHANGE FONTS STEP BY STEP
To change fonts do the following:

1. Select Options from the main menu (ALT O)
2. Select Change font from the Options menu (ALT F)

Next select one of the following:
The top Change button for screen fonts
Or the bottom Change button for printer fonts
Or the Finished button to return to the main menu.

To change the fonts do one or more of the following:
Select the Head Font.
From the drop-down lists, choose the name, style, and size of the font you want to use in 
the reports or on the screen.
Select OK to save your new font selections.

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



SORT OPTIONS OVERVIEW
Sorting options allow you to determine in what order accounts are viewed on the screen and in 
the reports.

The sort options are:
AS ENTERED
ACCOUNT BALANCE (Ascending or Decending)
INTEREST RATE (Ascending or Decending)
PAYMENT AMOUNT (Ascending or Decending)

To choose a Payoff!® topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



SORT OPTIONS STEP BY STEP
The sort options allow you to determine in what order accounts are view on the screen and in the 
reports.

Do the following:
1. Select Options from the main menu (ATL O)
2. Select Sort from the Options menu (S)
3. Select one of the following sort options:

AS ENTERED
ACCOUNT BALANCE (Ascending or Decending)
INTEREST RATE (Ascending or Decending)
PAYMENT AMOUNT (Ascending or Decending)

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



DISPLAY OPTIONS OVERVIEW
This option allows you to decide what is displayed on the main screen. 

The display options are :

ACCOUNT NUMBER

ACCOUNT BALANCE

ACCOUNT BALANCE DATE

PAYMENT FREQUENCY

NUMBER OF PAYMENTS

INTEREST RATE

MINIMUM INTEREST CHARGE

REGULAR OVERRIDE PAYMENT AMOUNT

MINIMUM PAYMENT AMOUNT

MINIMUM PAYMENT PERCENT

TOTAL INTEREST PAID

TOTAL AMOUNT PAID

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



FILE OVERVIEW:

To work on a file, you must first open and display it on your screen. You can then print, add, 
delete, and change the accounts. 

To preserve your work, you must save it to store the version of the accounts you see on your 
screen in a file on a disk. When you are done select EXIT from the FILE menu.

Also see Payoff! Categories:

File Opening Overview

File Saving Overview

File New Overview

File Exit Overview

To choose a Payoff!topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



FILE OPENING OVERVIEW

When you start PAYOFF!, an empty account list displays on the screen. 

From the FILE menu choose one of the following:

If you were working on a list of accounts and would like to start over with a "clean sheet 
of paper" choose NEW

Or choose OPEN to continue work on a previously saved file.

Also see Payoff! Category

File Opening Step By Step

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



FILE OPEN STEP BY STEP

In the File Name box, type the full name of the document including the extension.

If the document you want to open is not stored in the current drive or directory, do one or more of 
the following:

In the Drives box, select a new drive.

In the Directories box, select a new directory.

Choose the OK button.



FILE SAVING OVERVIEW

When you open an existing file, PAYOFF! copies it from the disk where it is stored and displays 
the copy of the accounts in the work area window. As you work, you are making changes to the 
copy of the file. To keep your latest work safely on the disk, you should frequently save your file.

Each time you save a file, the file remains open on your screen so you can continue work. When 
you finish working with PAYOFF!, close it by selecting EXIT under the FILE menu.

Choose a file name that is eight characters of less and begins with a letter of the alphabet. Also, 
add up to three characters for the extension. If you leave the extension off, the "POD" suffix is 
added for you. This extension will help you identify your PAYOFF! account files.

Also see Payoff! Category:

File Saving Step By Step

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



FILE SAVE STEP BY STEP

To save a new or unnamed group of accounts

Do one of the following:

From the File menu, choose Save As (ALT, F, A).

From the File menu, choose Save (ALT, F, S).

Do one of the following:

Save the document in the current drive and directory, type a name of up to eight 
characters in the File Name box.

Note: PAYOFF! automatically adds a "POD" extension unless you specify a different 
extension of up to three characters. 

Save the document in a different drive or directory, do the following:

1. In the Drives box, select a drive.

2. In the Directories box, select a directory.

3. Type the filename or the complete path in the File Name box.

Choose the OK button.



NEW FILE OVERVIEW

The NEW option is where you start entering your loan information. This option provides you with 
"a clean sheet of paper" that you can add loans too.

Also see Payoff! Category:

New File Step By Step

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



NEW FILE STEP BY STEP

The new option allows you to start with "a clean sheet of paper."

To add new accounts you will do the following:

Select EDIT from the menu (ALT E)

Select ADD (A)

Enter appropriate information

Also see Payoff! Category:

Overview of Editing

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



EXIT FILE OVERVIEW

This option is when you are done using Payoff! for the time being. If you have made changes 
Payoff! will ask you if you want to save your work.

Also see Payoff! Category

Editing Overview

To choose a Payoff! topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.

When the pointer is over the topic, the pointer changes to a hand icon.



EXIT PAYOFF!® STEP BY STEP

If you have made changes since you last saved, PAYOFF! asks whether you want to save the 
changes before quitting.

Do one of the following:

From the File menu, choose Exit (ALT, F, X).

Or press ALT+F4.

Or double-click the application Control menu box.



INSTALLATION SECTION
To install PAYOFF! run the Setup program, and do the following:

Insert the install disk in your floppy disk drive (in this procedure, drive A).
From the File Manager File, select drive A.
Then select    SETUP.EXE.
Follow the instructions that appear on your screen.



0% LOAN

A 0% loan is a loan that has no interest charges associated with the repayment of the loan. When
you make a payment on a zero percent loan all of the payment goes toward reducing the 
outstanding balance.



CREDIT CARDS

A credit card is a card that is issued by a business or bank that authorizes you to buy goods or 
services on credit.



REGULAR LOAN

A regular loan has constant equal payments. When a payment is made to repay this loan only 
then principle portion goes to reduce the loan's balance. The interest portion of the loan goes to 
the lending institution as their profit for loaning you the money. This type of loan is more 
commonly referred to as a mortgage or an installment loan.



ACCOUNT BALANCE

This is the amount that you owe on a loan as of a given date.



ACCOUNT BALANCE DATE

This is the date that the   Account Balance   was valid.



ACCOUNT NUMBER

This can be the actual account number of your loan or any descriptive names that will allow you 
to identify a specific loan. This description must be unique, as compared to the other loan 
descriptions.



ADDITIONAL PAYMENT AMOUNT

The additional payment is from sources other then what Payoff! can reapply once a loan is paid 
off..



ANNUAL INTEREST RATE

This is the yearly interest rate of a loan, as expressed by a percentage.

For example: 
A loan with a ten and one half yearly interest rate would be entered into Payoff! as 10.5. percent



AS ENTERED

This is just as you entered your loans. This is sometimes referred to as the natural order.



AS OF

The term "as of" is short for as of a given calendar date.

An example:
Your balance is one thousand dollars as of January 1 this year.



ASCENDING SEQUENCE

Payoff! sorts text alphabetically or numerically based on the farthest left character in the text. You 
can choose to sort the text in ascending or descending sequence.

Payoff! sorts alphanumerically (by numbers first, then letters). With this method, beginning with 
punctuation marks come before all others, those beginning with numbers come next, and those 
beginning with letters come last.

By sorting alphanumerically in ascending sequence punctuation marks come first. The numbers 
are sequenced from zero progressing though nine are next. Lower case letters are sequenced "a"
progressing through "z". are next. , and upper case letters starting with "A" progressing through 
"Z" are last.

To choose a Payoff! Topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



CURRENT BALANCE

Current balance is the amount you still owe as of a given date. 

An example:
Your current balance is one hundred fifty dollars as of the first of this month.

To choose a Payoff! topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



DESCENDING SEQUENCE

Payoff! sorts text alphabetically or numerically based on the farthest left character in the text. You 
can choose to sort the text in ascending or descending sequence.

Payoff! sorts alphanumerically (by numbers first, then letters). With this method, beginning with 
punctuation marks come before all others, those beginning with numbers come next, and those 
beginning with letters come last.

By sorting alphanumerically in descending sequence the upper case letters starting with "Z" 
progressing through "A" are first. The lower case letters sequenced "z" progressing through "a" 
are next. The numbers start with "9" progress through "0" are next. The punctuation marks are 
last.

To choose a Payoff! topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



FONT

A font is a collection of type faces or styles used to give your text a particular look.Choosing the 
appropriate point size for text can set the voice for a document and affect its readability. Your 
choice of type styles and sizes depends on the printers you have installed.

Currently only "fixed fonts" are available for your use.



HIGHEST INTEREST AMOUNT

This will identify the loan that you are paying the highest interest rate on.



HIGHEST INTEREST RATE

This will select the loan with the highest interest rate.



HIGHEST NUMBER OF PAYMENTS

This allows Payoff! to sequence the loans for you with highest number of payments appearing 
first and the lowest number of payments last.



HIGHEST PRINCIPAL AMOUNT

This allows Payoff! to sequence the loans for you with the highest principal portion of the 
payments appearing first and the loans with the lowest principal portion of the payments as last.



HIGHEST TOTAL PAYMENTS

This will total the all the payments for each loan then select the loan with the largest total amount.



INTEREST RATE

This is the interest rate that is to be paid on this loan.



MAKE EXTRA CASH AVAILABLE FOR USE

By selecting this option you are telling PAYOFF! that when this loan is paid in full to use the 
dollars that were being applied to this loan and apply the same dollar amount to the remaining 
outstanding loans based on selected parameters.



MAXIMUM PAYMENT AMOUNT

This is the maximum dollar amount you want a payment to be.



MINIMUM INTEREST AMOUNT

This is the lowest interest amount due regardless of the account_balance.



MINIMUM INTEREST CHARGE

This is the minimum interest charge that you must pay even if the calculated interest payment is 
less then this charge.



MINIMUM PAYMENT AMOUNT

This is the lowest payment amount you can make.



MINIMUM PAYMENT PERCENT

This is the lowest payment amount you can make based on the current balance.

To choose a Payoff! topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



MONTHLY

The term "monthly" refers to a loan that is paid once a month.    Payoff!® assumes is that a 
"monthly" loan becomes due on the same day each month regardless when it is due within the 
month.



NUMBER OF PAYMENTS

This is the number of payment remaining on a loan.



PAYMENT AMOUNT

This is the amount of each payment. 



PAYMENT FREQUENCY

How often you make a payment is called the frequency. A loan payment made once a month 
would have a payment frequency of monthly.

To choose a Payoff! topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



REGULAR OVERRIDE PAYMENT AMOUNT

In place of the regular payment amount you pay this override amount.

To choose a Payoff! topic:

Click the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



REGULAR PAYMENT AMOUNT

This is the dollar amount that you would normally pay as a payment.



REGULAR PAYMENT OVERRIDE

A dollar amount other then the regular payment amount.



TOTAL AMOUNT PAID

Total amount paid represents all the dollars you paid toward a loan added as one lump dollar 
amount.



TOTAL INTEREST PAID

Total interest paid represents all the dollars you paid toward the interest portion of a loan added 
as one lump dollar amount.



USE EXTRA CASH WHEN AVAILABLE

If extra cash is available then it will be applied whenever appropriate.



LOGICORP, INC. SOFTWARE LICENSE AGREEMENT

This document is a legal agreement between "you" the end user and "I or Me" Logicorp, Inc.    BY 
USING THIS SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT.    IF YOU DO NOT AGREE TO THE TERMS OF THE AGREEMENT PROMPTLY 
DISCONTINUE USE OF THE SOFTWARE.

PAYOFF is not public domain software.    PAYOFF is not FREE software.    PAYOFF is currently a 
SHAREWARE    program and requires you to register the program if you intend to use it beyond the 
Evaluation Period.

If you find PAYOFF useful and intend to use it, please register your copy as described.
Your registration will not have non-critical processes disabled, will help support PAYOFF's continued 
development and enable you to obtain future updates, fixes, enhancements, and extensions to the 
product.

LIMITED WARRANTY

This software is provided AS-IS.    There are no warranties, expressed or implied.

LOGICORP, INC. DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER LOGICORP, INC., NOR ANYONE 
ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS 
SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY    TO USE SUCH SOFTWARE EVEN IF 
LOGICORP, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN 
NO EVENT SHALL LOGICORP, INC.'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE 
PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE 
PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF
THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or incidental damages, so
the above limitation may not apply to you.

This agreement shall be governed by the laws of the State of Illinois and shall insure to the benefit of 
Logicorp, Inc. and any successors, administrators, heirs and assigns. Any action or proceeding brought 
by either party against the other arising out of or related to this agreement shall be brought only in a 
STATE or FEDERAL COURT of competent jurisdiction located in Cook County, Illinois.    The parties 
hereby consent to in personam jurisdiction of said courts.

This software and the disks on which it is contained are licensed to you, for your own use.    This is 
copyrighted software.    You are not obtaining title to the software or any copyright rights.    You may not 
sublicense, rent, lease, convey, modify, translate, convert to another programming language, decompile,
or disassemble the software for any purpose.



You may make as many copies of the software as you need for backup purposes.    You may use this 
software on more than one computer, provided there is no chance it will be used simultaneously on 
more then one computer.    If you need to use the software on more than one computer simultaneously, 
please contact us for information about site licenses.

All users of PAYOFF are granted limited license to copy the product only for trial use by others and/or 
upload to a electronic bulletin board system (BBS) with the Sysop's permission, subject to the above 
limitations, provided that PAYOFF is copied in its full, unmodified, and unregistered form.    That is, the 
copy must include all files necessary to permit full unregistered operation of the program, and any 
additional files included with the distribution package. No fee, charge, license, warranty, registration 
obligation or other compensation of any kind may be accepted by the donor or recipient in exchange for 
a copy of PAYOFF, other than reasonable distribution costs which must not exceed $10.

As an Unregistered user you are granted a limited license to use PAYOFF on a trial basis for evaluation 
and determining if PAYOFF is suitable for your needs.    Use of PAYOFF, except this limited purpose, 
requires you to register the product.    The UNREGISTERED version of PAYOFF is fully functional, 
except that some noncritical processes are disabled.    REGISTERED USERS have all the product 
functions available.

For further information: Should you have any questions concerning this Agreement, or if you want to 
contact Logicorp, Inc. for any reason, please write: Logicorp, Inc. / 20 Fillmore Lane / Streamwood, IL 
60107-1380.    If you need technical support for a Logicorp, Inc. Products please call or fax (708) 830-
4878.    Our technical support hours are 9am to 5pm CST.

All Logicorp, Inc. products are trademarks or registered trademarks of Logicorp, Inc.    All other brand 
and product names are trademarks or registered trademarks of their respective holders.

©1992-1993 Logicorp, Inc. All Rights Reserved.



COMPUTE OVERVIEW
Compute will do all the necessary computations for you to determine a PAYOFF!based
on your loan and personal options.

In addition to reapplying dollar amounts from loans as they are paid off to 
outstanding loans you can and an additional payment amount.

Using Help Contents

Also see PayoffCategory:

Compute Step by Step

To choose a Payoff! topic:

Select the green underlined topic you want to view

Or press TAB to select the topic. Then press ENTER. When the pointer is over 
the topic, the pointer changes to a hand icon.



COMPUTE STEP BY STEP
The COMPUTE option allows you to instruct PAYOFF!to crunch the numbers so you can
see the results.

To crunch the numbers do the following:

Select Compute from the Main Menu (ALT C)

Add the following optionally:

EXTRA CASH/MONTH
EXTRA CASH INCREMENT
EXTRA CASH MAXIMUM

Select how to apply extra cash.

From the drop-down list, choose how you want extra cash 
applied.

The options are:

HIGHEST INTEREST RATE
HIGHEST INTEREST AMOUNT
HIGHEST TOTAL PAYMENTS
HIGHEST NUMBER OF PAYMENTS

Do the following optionally:

Rotate through all compute precedences
Automatically print recap report

Double click one of the following buttons:

COMPUTE or
CANCEL

By selecting the COMPUTE button you will see a bar graph showing you the 
percentage completed. You can select the CANCEL button anytime prior to the 
bar graph reaching 100 percent. When done you will return to the main menu. 
Also the report option (ALT R) is now available.



REPORTS OVERVIEW
The report's feature allows you to display or print the results of the PAYOFF!® 
computations.
The various reports are:

ACCOUNT RECAP
ANALYSIS BY DATE [DETAIL]
ANALYSIS BY DATE [SUMMARY]
ANALYSIS BY ACCOUNT [DETAIL]
ANALYSIS BY ACCOUNT [SUMMARY]
COMPUTE RECAP ANALYSIS
LOAN AMORTIZATION

To choose a Payoff!® topic:

Select the green underlined topic you want to view.

Or press TAB to select the topic. Then press ENTER.
When the pointer is over the topic, the pointer changes to a hand icon.



OVERVIEW OF EDITING

Editing will allow you to add, change, and delete information pertaining to your loans. For more 
detailed information select one of the following:
Data Entry Fields
Buttons
Add Account Overview
Edit Account Overview
Delete Account Overview
Copy Account Overview
Cut Overview
Paste Overview
Add Account Step By Step
Edit Account Step By Step
Delete Account Step By Step
Copy Account Step By Step
Cut Step By Step
Paste Step By Step



BUTTONS

OK
You are confirming that the information pertaining to the loan is correct.    If you want to 
change this information latter you can do so by the EDITING option on the menu bar.

SOLVE
Once the SOLVE button becomes active, Payoff!® is informing you that it has enough 
information to deduce the remaining information. When you click on the SOLVE button 
you will see the additional information filled in automatically.
If the SOLVE button is inactive or grayed, Payoff!® does not have enough information yet
to solve for the missing information.

UNDO
This button will reset all fields to the values that existed when first entering the EDIT 
screen.

CANCEL
This button will cause all new or changed information to be ignored and control returned 
to the menu screen.

PRINT
This button will copy the loan information you are looking at to your printer (if you have a 
printer). See the Microsoft Windows manuals for information on setting up printers.



DATA ENTRY FIELDS

To get a definition of the a field double click on the green word.
0% LOAN
ACCOUNT NUMBER
ANNUAL INTEREST RATE
AS OF
CREDIT CARD
CURRENT BALANCE
MAKE EXTRA CASH AVAILABLE FOR USE
MAXIMUM PAYMENT AMOUNT
MINIMUM INTEREST AMOUNT
MINIMUM PAYMENT PERCENT
NUMBER OF PAYMENTS
PAYMENT FREQUENCY PAYMENT
REGULAR LOAN
REGULAR PAYMENT AMOUNT
REGULAR PAYMENT OVERRIDE
TOTAL AMOUNT PAID
TOTAL INTEREST PAID
USE EXTRA CASH WHEN AVAILABLE



ADD ACCOUNT OVERVIEW

Here you enter new accounts. You enter as much information as you know about your loan.    
When the SOLVE button becomes active, PAYOFF!® can solve for the remaining information 
about your loan by selecting the SOLVE button.
Also see Payoff! Categories:

Edit Account Overview
Delete Account Overview
Copy Account Overview
Cut Account Overview
Paste Account Overview

To choose a Payoff! Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



ADD ACCOUNT STEP BY STEP

To add new accounts to PAYOFF do the following:
From the Edit Menu, choose Edit (ALT E)
Select Add Account form the pull-down Menu(CTRL + A)
From the Account Entry window, choose a loan type
Fill in loan information

When this loan is paid off:
Decide if extra cash is available for use by outstanding loans by selecting XXXX.
Decide if this loan can use extra cash if available by selecting XXX.

Also see Payoff! Categories:
Delete Account Step by By Step
Copy Account Step by By Step
Cut Account Step by By Step
Paste Account Step by By Step

To choose a Payoff! Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



EDIT ACCOUNT OVERVIEW

Here you can edit existing accounts. You change as much information as you need too amount 
your loan.    When the SOLVE button becomes active, PAYOFF!® can solve for the remaining 
information about your loan by selecting the SOLVE button.
Also see Payoff!® Categories:

Add Account Overview
Delete Account Overview
Copy Account Overview
Cut Account Overview
Paste Account Overview

To choose a Payoff!® Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



EDIT ACCOUNT STEP BY STEP

To edit an exicting account in PAYOFF!® do the following:
From the Edit Menu, choose Edit (ALT E)
Select Edit Account form the pull-down Menu(CTRL + E)
Change information

Also see Payoff!® Categories:
Add Account Step by By Step
Delete Account Step by By Step
Copy Account Step by By Step
Cut Account Step by By Step
Paste Account Step by By Step

To choose a Payoff!® Topic:
Select the green underlined topic you want to view.
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



DELETE ACCOUNT OVERVIEW

Here you delete existing accounts. You can not restore a deleted account.
Also see Payoff!® Categories:

Add Account Overview
Edit Account Overview
Copy Account Overview
Cut Account Overview
Paste Account Overview

To choose a Payoff!® Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



DELETE ACCOUNT STEP BY STEP

To delete and existing account in PAYOFF!® do the following:
From the Menu screen first select the account that you want to delete.
From the Edit Menu, choose Edit (ALT E)
Select Delete Account form the pull-down Menu(CTRL + D)

Also see Payoff!® Categories:
Add Account Step by By Step
Copy Account Step by By Step
Cut Account Step by By Step
Paste Account Step by By Step

To choose a Payoff!®:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



COPY ACCOUNT OVERVIEW

This is a method that help you copy an existing account in PAYOFF!®.    This is useful when you are 
about to add a new account that is similar to an account you have already entered.

Also see Payoff!® Categories:
Add Account Overview
Edit Account Overview
Delete Account Overview
Cut Account Overview
Paste Account Overview

To choose a Payoff!® Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



COPY ACCOUNT STEP BY STEP

To copy an accounts in PAYOFF!® do the following:

From the Main screen select an account.
From the Edit Menu, choose Edit (ALT E)
Select Copy Account form the pull-down Menu(CTRL + T)

Also see Payoff!® Categories:
Add Account Step by By Step
Delete Account Step by By Step
Cut Account Step by By Step
Paste Account Step by By Step

To choose a Payoff!® Topic:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



CUT OVERVIEW

This helps you transfer an account from one file to a different file.

Also see Payoff!® Categories:
Add Account Overview
Edit Account Overview
Delete Account Overview
Copy Account Overview
Paste Account Overview

To choose a Payoff!®:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



CUT STEP BY STEP

To add cut an account in PAYOFF!® do the following:

From the Main screen select an account
From the Edit Menu, choose Edit (ALT E)
Select Cut Account form the pull-down Menu(CTRL + T)

The account is then removed from the current file.
Form the Main menu select File Save
Select File open....
See paste
Also see Payoff!® Categories:

Add Account Step by By Step
Delete Account Step by By Step
Copy Account Step by By Step
Paste Account Step by By Step

To choose a Payoff!®:
Select the green underlined topic you want to view
Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



PASTE OVERVIEW

This is the next step after Cutting and account. This moves a cut acount from the holding area to the 
current file.

Also see Payoff!® Categories:

Add Account Overview
Edit Account Overview
Delete Account Overview
Copy Account Overview
Cut Account Overview

To choose a Payoff!®:

Select the green underlined topic you want to view

Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



PASTE STEP BY STEP

To add new accounts to PAYOFF!® do the following:

From the Edit Menu, choose Edit (ALT E)
Select Add Account form the pull-down Menu(CTRL + A)
From the Account Entry window, choose a loan type.
Fill in loan information

When this loan is paid off:
Decide if extra cash is available for use by outstanding loans by selecting XXXX.
Decide if this loan can use extra cash if available by selecting XXX.

Also see Payoff!® Categories:

Add Account Step by By Step
Delete Account Step by By Step
Copy Account Step by By Step
Cut Account Step by By Step

To choose a Payoff!®:

Select the green underlined topic you want to view

Or press TAB to select the topic. Then press ENTER. When the pointer is over the topic, 
the pointer changes to a hand icon.



PAYOFF!® 2.01e ORDER FORM

Send or Fax completed form to:

Logicorp, Inc.

PAYOFF!® 2.01e Order Dept.

20 Fillmore Lane

Streamwood, IL    60107-1380

Fax:    (708) 830-4878

PAYOFF!® 2.01e

Quantity: ________ @ $ 49.00 each ______________

Sales Tax (IL residents only 8.25%) @ $    4.04 each ______________

Shipping and Handling (Only if Disk Needed) @ $    2.50 each ______________

Shipping (Overseas orders only) @ $10.00 each ______________

Total ______________

Payment by: (PLEASE DO NOT SEND CASH)

 ___ Check ___ Money Order ___ VISA __ MasterCard ___ Carte Blanche/Diners ___ JCB

Credit Card Number: ______________________________________ Exp. Date: _______/______

Signature: _____________________________________________________________

Registered User Information: (PLEASE PRINT)

Name: ____________________________________________________________________

Company: ____________________________________________________________________

Address: ____________________________________________________________________

____________________________________________________________________

City: ____________________________________________________________________

State, Zip ____________________________________________________________________

Country ____________________________________________________________________

Daytime Phone: (______) ______-__________

Evening Phone: (______) ______-__________

Fax              (if any): (______) ______-__________

Required Diskette Format ______ 5.25 ______ 3.5 ______ NO DISK NEEDED

Where did you find PAYOFF!® 2.01e?

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________



Benefits Of Using

Over the past couple of years many people like ourselves have taken on a little 
bit more indebtedness then they found comfortable. It seems the financial future 
of our economy is sometimes questionable because of the amount of debt our 
country has accumulated.

However, many people are aware that getting out of debt or at least reducing 
debt is a good idea. Some debt is for the most part unavoidable, like buying a 
house or even buy a new car. However, debt still needs to be managed.

You could sit and list all your debts and create a payment schedule for each 
creditor. However this only shows you creditor by creditor what you owe. What is 
need is a tool that will show all your creditors together and most important, a 
realistic plan to payoff or reduce our indebtedness.

This is why PAYOFF! was written. By entering information about your loans into 
PAYOFF! you have a starting point to manage and payoff your debit. You can 
create different what-if scenarios to compare them to your needs and goals. 
As in any matter of fiance, consult with your accountant prior to starting any plan. 
An accountant can provide a complete picture of your finances.



Context Help
Context Sensitive Help does NOT exist.    However, a list of Help topics does exist. See Help on 
Main Menu.



HELP CONTENTS
Clicking any topic in this screen leads to a separate index of Help topics about that item. For an 
extensive index to Payoff!® 2.01e, one like the traditional index at the end of a book, select the Search 
button in this window.
To choose a topic:

Click the green underlined topic you want to view.
Or press TAB to select the topic.    Then, press ENTER.    When the pointer is over the topic, 
the pointer changes to a hand icon.

Topics:
Benefits of Using Payoff!® 2.01e
Installatiation

Files
Edit
Compute
Reports
Options

Logicorp, Inc.'s Outstanding Support
Your Next Release

So Why Register?
About Shareware

Software License Agreement
Order Form

©1992-93 Logicorp, Inc. All Rights Reserved



SO WHY REGISTER?
Here's four good reasons:

1. Customer Support
You will have access to Logicorp Inc.'s outstanding customer support

2. Upgrade Information
Advance notice of new versions and special prices!

3. Product Information
Be the first to hear of product developments, enhancements, and add-ins, as well as other new Logicorp
products.

4. It's the right thing to do!
If you are using the program, it only seems right to register.



NEXT RELEASE
Payoff!® 2.01e is improved -- by you, a registered owner.    
As a registered owner you can request that Logicorp include your ideas into the next release.    Besides 
if you're the first to submit an idea that is included in a future release you will receive that release free.
See About Shareware and Order Form



LOGICORP, INC.'S OUTSTANDING SUPPORT
We provide excellent after-sale assistance for trail systems and also registered systems.
When requesting technical support, please include your name, daytime phone number, registration 
number (if registered) and version number.
Fax 708/830-4878
CompuServ ID# 76450,2051
Mailing Address
Logicorp, Inc.
Payoff!® 2.01e Support
20 Fillmore Lane 
Streamwood, IL 60107-1380



You can FAX your forms to Michael Green at Logicorp, Inc. (708) 830-4878
Payoff!® 2.01e Bug Report Form

(Please use this one page form for each problem you encounter)

Your Name:

Your Phone Number:

Your Fax Number:

Date:

Description of Problem

List of Steps you took to Recreate Problem

Results(what went wrong)

What you expected would happen




